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Preface 

This document describes the changes that Release 5.0 of the MacMainFrame 
software brings to the MacMainFrame product line. (Release 5.0 includes all of the 
features in Release 4.0 of the MacMainFrame software.) 

You can use this manual with the following MacMainFrame products: 

Part No. Descr!Q_tion For Macintosh 
89-2545-000 MMF Coax Workstation Macintosh II Family 

Macintosh Quadra 
89-2560-000 Macintosh SE/30 
89-2565-000 Macintosh SE 
89-2555-000 Macintosh LC or LC II 
89-2530-000 MMFDX Unit All Macintoshes 
89-2801-000 MMF Token-Ring Workstation Macintosh II Family 

Macintosh Quadra 
89-3001-000 Macintosh SE/30 
89-2901-000 Macintosh SE 
89-3201-000 MMF SDLC Workstation Macintosh II Family 

Macintosh Quadra 
89-3301-000 Macintosh SE/30 

89-2750-000 MMF Coax Gateway Macintosh II Family 
Macintosh Quadra 

89-2700-000 Macintosh SE/30 
89-2730-000 Macintosh SE 
89-2760-000 Macintosh LC or LC II 
89-2808-000 MMF Token-Ring Gateway Macintosh II Family 
89-2832-000 or Macintosh Quadra 
89-2864-000 
89-3008-000 Macintosh SE/30 
89-3032-000 
89-3064-000 
89-2908-000 Macintosh SE 
89-3208-000 MMF SDLC Gateway Macintosh II Family 
89-3232-000 or Macintosh Quadra 
89-3264-000 
89-3308-000 Macintosh SE/30 
89-3332-000 
89-3364-000 
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Part No. Descr~tion For Macintosh 
89-2570-000 MMF Graphics Option Macintosh LC or LC II 

Macintosh II Family or 
Macintosh Quadra 

Macintosh SE/30 

Audience 

This manual is for people who install MacMainFrame products, people who 
administer MacMainFrame networks, and people who use MacMainFrame 
applications. 

How To Use This Document 

vi 

This document covers changes that Release 5.0 and Release 4.0 of the 
MacMainFrame software bring to the MacMainFrame product line. Release 5.0 of 
the software includes all of the features in Release 4.0. And this document includes 
the entire contents of the MMF 4.0 Release Notice and the MMF 4.0 Release Notice 
Addendum. 

If you are upgrading from 

• Release 4.0 to Release 5.0, read Chapters 1 and 2. 

• A release earlier than Release 4.0, read Chapters 1, 2, and 3. 

If you have never used MMF before, read Chapters 1, 2 and 3. 

Chapter 1 

Chapter2 

Chapter3 

- Introduction 

- MacMainFrame 5.0 

- MacMainFrame 4.0 

Be sure to use this Release Notice with the manuals that come with your 
MacMainFrame product(s). See the "Related Documents" section below. 



Related Documents 

Coax Workstation Installation Guide Avatar Part No. 65-2500-101 

Token-Ring Workstation Installation Guide Avatar Part No. 65-2800-101 

SDLC Workstation Installation Guide Avatar Part No. 65-3200-101 

Coax/Token-Ring!SDLC Workstation User's Guide 

Coax/Token-Ring!SDLC Gateway Server 
Administrator's Guide 

Avatar Part No. 65-2500-100 

Avatar Part No. 65-2700-000 

Coax/Token-Ring!SDLC Gateway Client User's Guide Avatar Part No. 65-2700-010 

Graphics Option User Guide Avatar Part No. 65-2570-000 

For More Information 

For additional information about a specific MacMainFrame product, see the latest 
Release Notices and Upgrade Notices for that product or product line. Contact your 
Avatar representative for more information. 

For More Help 

Contact Avatar Customer Support:1-800-282-8276. (In Canada, call 1-800-235-
8276.) 

Terminology 

For convenience, we'll occasionally refer to any MacMainFrame Series product as a 
MMF product hereafter. 

To refer to the MacMainFrame software, we'll sometimes say simply MMF when it's 
not important which module - the application, the drivers, or other software - is 
responsible for the given effect. 

vii 
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Chapter 1 

Introduction 

MacMainFrame 5.0 New Features 

Release 5.0 of the MacMainFrame software includes several new features: 

• MMF 5.0 supports Macintosh Quadra machines, Macintosh LC II machines, and 
Macintosh PowerBook machines. 

• MMF 5.0 Token-Ring and SDLC products support larger Maximum I-Frame Sizes, 
which increases the size of packets sent over the SNA network. 

• MMF 5.0 supports DO Structured Field-based file transfer. 

• MMF 5.0 lets you Print, Save, and Log the data in your 3270 window without 
requiring you to select the window. 

• MMF 5.0 lets MMF Clients connect to the IBM host through Avatar Netway 
gateways. 

• MMF 5.0 lets you keep your Server's configuration when you install a new version 
of MMF Server software. 

• MMF 5.0 lets MMF Clients connect to multiple MacMainFrame gateways or to 
multiple Netway gateways. 

• MMF 5.0 supports Apple's 16/4 Token-Ring hardware. 

Changes to User Interface 

In Release 5.0 there are also some changes to the MMF user interface that affect the 
way you set new session settings, select a server, and set up MMF 3287. 

Also in Release 5.0 we've consolidated the MMF Client application icon and the MMF 
Workstation application icon into one icon. Both MMF Client users and MMF 
Workstation users now use the same MMF 3270 application icon. 
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MMF 5.0 Includes all MMF 4.0 Features 

1-2 

Release 4.0 of the MacMainFrame software included several new features: 

• MMF 4.0 supports the new Macintosh hardware platforms. 

• MMF 4.0 has a new Special Settings menu that includes various new optional 
features. · 

• MMF 4.0 supports up to 64 LU session classes on MMF Gateway Server 
machines 

• MMF 4.0 allows a MMF Client to run on a MMF Gateway Server machine. 

• MMF 4.0 has consolidated driver icons for both CUT and OFT. 

• MMF 4.0 lets you restrict LU session classes. 

Under System 7.0, MMF 4.0's features also include: 

• MMF 4.0 has the new System 7.0 Help balloons feature. 

• MMF 4.0 supports other standard System 7.0 features such as Publish & 
Subscribe andTrueType. 

• MMF 4.0 has multicolored icons 
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What You Need First 

As with all releases of MMF, you need a Macintosh computer, Macintosh System 
software, and a network connection to your IBM host computer. 

In more detail: 

Using MMF 5.0 With Existing Hardware and Software 

Hardware 

No upgrades to your Avatar hardware are necessary to run MMF 5.0. 

MMF 5.0 runs on all Macintosh hardware platforms including the Macintosh Quadra, 
Macintosh LC II, and the Macintosh PowerBook. 

Software 

You don't need to upgrade your Macintosh System software, providing you're running 
the following version of the System software: 

If you're running Version 6 

If you're running Version 7 

6.0.7 at least 

7.0 at least 

Using Previous Session Settings Documents 

IMPORTANT: If your Session Settings documents were created with MMF version 
3.35 or later, you can use them as js with MMF 5.0. When you're ready to save these 
old documents, MMF 5.0 will save them in the new format. 

MMF 5.0 cannot read Session Settings documents made by MMF software .earLie.r 
than MMF 3.35 If you need information from these older documents, open them 
under your old MMF software, copy the information by hand, and then enter the 
information into new Session Settings documents that you create using MMF 5.0. 
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NOTE: If you were running MMF Client software, you won't be able to open your 
older Session Settings document by double-clicking on the document icon. This is 
because we've replaced the MMF Client application with the MMF 3270 application 
icon. To open a MMF Client Session Settings document using the new MMF 3270 
software you must: 

1. Launch the new MMF 3270 application. 

2. In the File menu, select Open. 

3. Select the Session Settings document that you want to open. 

Once you save the Session Settings document, you will be able to open your Session 
Settings document by double-clicking on the document icon. 

Using Previous Server Configuration 

1-4 

Version 5.0 of the Server Control application has a new feature called Import 
Configuration which imports your class definitions from your old MMF Server drivers. 

See the section called "Import Configuration Feature for MMF Server Control" below. 
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Installation 

IMPORTANT: Before you install MMF 5.0 software, you must remove your old MMF 
software from your hard disk drive so that your new MMF 5.0 software can function 
properly. 

Once you've saved the information you need from older Session Settings documents 
(documents created with software earlier than MMF 3.35), and you've removed older 
MMF icons, you can install the MMF software as usual. 

Be sure to discard the following old MMF icons: 

• For MMF Workstation, discard 

- old MMF Workstation application 

- old Avatar icon (control panel document) 

- old driver icon (either Coax, Token-Ring, or SDLC) 

- old MMF 3287 icon 

- old Armon and Armonk font icons 

- old Checker 

• For MMF GW Client, discard: 

- old MMF GW Client application 

- old Net 3270 Chooser icon 

- old ADSP system document 

- old MMF 3287 icon 

- old Armon and Armonk font icons 

REMEMBER: In Release 5.0 we've consolidated the MMF Client application icon 
and the MMF Workstation application icon into one icon. Both MMF Client users 
and Workstation users now use the same MMF 3270 application icon. 

• For MMF GW Server, 

DON'T DISCARD your old driver icon if you wish to save your existing server 
configuration. See the Import Configuration feature for MMF Server Control in 
Chapter 2 or more information. 

However, you DO need to discard: 

- old Server Control application 

- old Checker 
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• If you're installing any MMF 5.0 Token-Ring product - either MMF Token-Ring 
GW Client, MMF Token-Ring Workstation, or MMF Token-Ring GW Server - also 
discard: 

- old AvaTR software 

REMEMBER: You must install your new version of Ava TR software. See your 
Token-Ring Workstation Installation Guide or your Coax/Token-Ring/SDLC 
Gateway Administrator's Guide for information on how to install Ava TR. 
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Chapter 2 

MacMainFrame 5.0 

MMF 5.0's New Features 
This chapter is divided into sections that cover: 

• MMF Session Settings 

• MMF Clients connecting to Netway Gateways 

• Larger Maximum I-Frame Size for Token-Ring and SLDC products 

• DO Structured Field-based File Transfer 

• Printing, Saving, and Logging entire 3270 windows 

• Import Configuration feature for MMF Server Control 

• MMF 3287 user interface 
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MMF Session Settings 
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The MMF Session Settings dialog box has been replaced with the Session 
Parameters and Display Settings dialog boxes. The following sections describe how 
to set: 

• Session Parameters -

• MMF Workstation Users 

• MMF Client Users 

• MMF DX Users 

• Display Settings - All Users 

As with earlier versions of MMF, you can save your settings in a Session Settings 
document. 
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Session Parameters- MMF Workstation Users 

1. To begin a new session, pull down the File menu and select New (or New 
Session ... ). 

MMF will display this dialog box: 
Please Select Session Parameters: 

LU Number: I ~ 2 I 
Screen Size: I ~ 24 rows, 80 cols (Mod 2) 

D Use EHtended Rttributes 

Cancel n Connect D 

2. Fill in this screen as you normally would. 

MacMainFrame 5.0 2-9 



Session Parameters - MMF Client Users 

There are some differences in the way you select a server using MMF 5.0. Instead of 
using the Chooser to select a server, you now pull down the File menu and select 
New (or New Session ... ). MMF will then present the Select Session Parameters 
dialog box. Example: 

Please Select Session Parameters: 

AppleTalk Zone: 

Loc.alTalk EAST r!1 
LocalTalk lruine 
LocalTalk WEST 
Nouell EAST 
Nouell WEST 
Peripherals 
TokenTalk Seruices 
TokenTalk Users 

To open a new session: 

I 
Seruer: 

Computer Room SDLC r!1 
Class: 

Model-2 
Model-2 APR 
Model-2 ERB 
Model-3 
Model-3 APR 

Cancel ) ( Connect J 

1. In the Apple Talk Zone: box, select the AppleTalk Zone where the server that 
you wish to connect to is located. 

The Server: box will then display a list of MMF Servers that are available in 
that zone. 

2. In the Server: box, select a Server. 

The Class: box will then display a list of session classes that are available on 
the server that you selected. 

3. In the Class: box, select a session Class. 

4. If you select a class that requires a password, a Password: box will appear in 
the Connection Settings dialog box. 

If it's required, fill in the correct password. 

5. Click Connect to get a new session. 
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Multi-Server Feature 

MMF's multi-server feature will let you open sessions on more than one MMF 
Gateway or on more than one Netway Gateways. However, you can't open sessions 
on MacMainFrame and Netway Gateways at the same time. 

To open additional sessions, pull down the File menu, select New Session ••. , and 
follow the steps above for opening new sessions. 
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Session Parameters- MMF DX Users 
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1. To begin a new session, pull down the File menu and select New (or New 
Session ... ). 

MMF will display this dialog box: 

2. Fill in this screen as you normally would. 

Documentation Error 

Please Select Session Parameters: 

Screen Size: I ~ 24 rows, BO cols (Mod 2) 

D Use EHtended Rttributes 

Serial Port: 

Baud Rate: 

Connection 
Sequence: 

Modem Delay Character: 

Password: 

Cancel 

1200 bps 

([ Connect J) 

Page C-86 of the MacMainFrame Coax Workstation Installation Guide, which explains 
the MMF DX Configuration Settings, should read: 

Modem Connection Signal Causes a remote DX unit to listen for an interpret data 
on the RX data line and transmit data over the TX data line on its modem as follows: 

• Monitor DCD (Hayes Compatible) Remote DX unit will not send or receive over 
the RX data and TX data lines until the DCD signal becomes active. 

• Monitor CTS (Other) Remote DX unit will not send or receive over the RX data 
and TX data lines until the CTS signal becomes active. 
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Display Settings. 

To set your Display Settings, pull down the Settings menu and select Dis p I a y ... 
MMF will present one of these Display Settings dialog boxes. 

Color Monitors: 

Monochrome 
Monitors: 

Display Settings 

Screen font size I 12 ,..I Print font size! liJ "'I 
Print font ._I _ll_r._m_o._n_J: _____ ,..~I 

Cursor style O Underline @Block 

D Use Host Cursor 181 Blinking 

Background 

•=!M• 
oo I 'w'hi\• 

•=!Ill• 
"4H9' 

Io •=ii+ 
.,. +;gp .,. •w+w MM§ijM 

[ Default Colors J 

OK Cancel 

Display Settings 

Screen font size I 12 ,..I Print font size! Ii) ,..I 
Print font I RrmonJ: ,..I 
Cursor style O Underline @ Block 

D Use Host Cursor 181 Blinking 

Background @ White 0 Black 

([ OK JI Cancel 

Fill in these dialog boxes as your normally would. 

NOTE: When you open a new 3270 session, MMF 5.0 will copy your display settings 
and apply them to your new session. 

You can now save your Connection Settings and Display Settings in a Session 
Settings document. 
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MMF Clients Connecting to Netway 

With Release 5.0, you can use MMF Workstation software to connect to the IBM host 
through Avatar's Netway 1000 and 2000 gateways. 

What You Need First 

2-14 

To use MMF Workstation software with a Netway, you'll need to: 

1. Copy the Netway Client driver icon 
and the Avatar icon, shown here, into 
your System Folder. 

2. Select the Netway Client driver in the 
Avatar Control Panel: 

3. Scroll through the list of languages 
that appear in the Control Panel and 

-+ 

select the language that's configured -+ 

on your BM host. See your IBM 
system manager for information 
about this language. 

4. Restart your Macintosh. 

-·- -·-
[8=: [!][!JI[!) 

Net'w' ay Client Avatar 

D Auatar 

.. 
s.o @If Oij 
Select connection method : 

Q'.!]-z._ ~ 

MMF SDLC MMF Token-... 

ll~ -0 
Austrian /German r--

~; ~~i~~an I 
~~~:t~a~~~~~~a l I l-!;;;;;;;::;;;::;;;::;;;::;;;::;;!;7)=-1 

En,g_lish UK {}-
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Opening a New Session 

1. Launch the MMF 3270 application. 

2. Pull down the File menu and select N e w ••.. 

MMF will display 
this Select Session 
Parameters 
dialog box: 

Please Select Session Parameters: 

RppleTalk Zone: 

Eng - 9999 
EtherTalk ERST 
EtherTalk WEST 

Locallalk WEST 
Nouell ERST 
Nouell WEST 
Peripherals 

I 
LU Name: I******** 

Screen Size: I ~ 24 rows, 80 cols (Mod 2) 

D Use EHtended Rttributes 

Cancel ( Connect D 

3. In the Apple Talk Zone: box, select the AppleTalk Zone where your Netway 
gateway is located. 

The Gateway: box will then display a list of Netways that are available in 
that zone. 

4. In the Gateway: box, select a Netway Gateway. 

5. If your system administrator has assigned LU Names to the Netway, you will need 
to fill in the appropriate LU Name in the LU Name: edit box. Check with your 
system administrator. 

6. Select your Screen Size: and if you wish ,select Use Extended Attributes. 

7. Click Connect to get a new session. 

You can now use MMF as you normally would. You can save your session settings 
and open new sessions. 
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Maximum I-Frame Size 

MMF Token-Ring and SDLC Workstation and Gateway products now support larger 
frame sizes for transmitting and receiving data over the SNA network. Maximum I -
Frame Size is the maximum amount of data in bytes that MMF can send or receive in 
one segment of a path information unit (PIU). A PIU is a unit of data transfer in the 
SNA protocol. (This doesn't affect the size of Apple Talk packets sent over the 
Token-Ring network.) 

You set the Maximum I-Frame Size using the Token-Ring or SDLC configuration 
panels as described below. 

IMPORTANT: MMF's Maximum I-Frame Size setting must match your host system 
configuration. (That is, the host's MAXDATA setting.) You should obtain the correct 
frame size from your IBM system manager or from your network administrator. 
MMF's default frame size is 265 bytes. 

For Token-Ring: 

2-16 

For MMF Workstations - In the Avatar 
Control Panel, click the 802.5 Setup ... 
button to get to the Token-Ring 
Parameters panel: 

Enter the correct number of bytes 
for your host configuration. MMF 
Token-Ring supports up to 4015 bytes. 

New Parameter > 

'*''' 
Set Token-Ring 
Parameters: 

Slot: 0 9 @ R 0 B 0 C 0 0 0 [ 
Burned- In Address: 00013F1B1 500 

Locally Administered 1400000000027 I 
Address: . . 
Ring Speed: @ 4 Mbps 0 16 Mbps 

Host"s Address: j 400000000001 I 
XID - Physical Unit Block: §] 
XID - Terminal ID: I 00001 I 
Maxi mum I-Frame Size (bytes): j 401 s j 

(cancel) [ OK ] 
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For MMF Gateway Servers 
- In the Server Control 
application, pull down the 
Administer menu and select 
Token-Ring Parameters ... 
to get to the Server Control's 
Token-Ring parameters 
panel: 

Enter the correct number of bytes 
for your host configuration. MMF 
Token-Ring supports up to 4015 
bytes. 

New Parameter • 

MacMainFrame 5.0 

Token-Ring Parameters 

Slot: @ 9 0 A 0 H 0 c 0 n 0 [ 

Burned-In Address: 

Locally Administered 
Address: 

Ring Speed: @4 Mbps 

00013F791400 

114000000000081 

Q 16 Mbps 

Host Address: I 40000000000 I I 
HID- Physical Unit Block: @:!2] 
HID- Terminal ID: I 00001 I 
MaHimum I-Frame Size (bytes): I 401 s I 

t OK Cancel 
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For SDLC: 

MMF Workstations - In the Avatar 
Control Panel, click the SDLC 
Setup ... button to get to the SDLC 
Parameters panel: 

Enter the correct number of bytes 
for your host configuration. MMF 
SDLC supports up to 2057 bytes. 

Im Set SDLC parameters: 

@ External Clock 

O Internal Clock 

@ NRZ 

0 NRZI 

§] 
@:22] 

New Parameter > 

Station Address 

Physical Unit Block 

Physical Unit ID (XI D) 

Maxi mum I -Frame Size 

1012341 

120571 

2-18 

MMF Gateway Servers - In the 
Server Control application, pull 
down the Administer menu and 
select SDLC Parameters to get 
to the Server Control's SDLC 
parameters panel: 

Enter the correct number 
of bytes for your host 
configuration. MMF SDLC 
supports up to 2057 bytes. 

New Parameter > 

(cancel) 

SDLC Parameters 

O EHternal Clock 

@ Internal Clock 

@ 

0 

NR2 

NR21 

Baud Rate: I 9600 bps 

Control Unit Address: ~ 
Physical Unit Block: 10111 

Terminal ID: 1012341 

MaHimum I-Frame Size (bytes): I 2057 I 

OK Cancel 
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Structured Field-based File Transfer 

MMF 5.0 supports DO Structured Field-based file transfer. DO Structured Fields is a 
feature of all recent versions of IBM's IND$FILE file transfer application. Structured 
Field file transfer is faster than the standard Screen-based method of file transfer. 

You don't need to make any changes to the host or to MMF in order to use this 
feature. If your host and 3270 session support structured field file transfer, MMF will 
automatically perform file transfers using DO structured fields. Otherwise, MMF will 
perform screen-based file transfers. In either case, the data uploaded or downloaded 
is the same. 

Contact your IBM system manager to find out whether or not your system supports 
DO structured fields. 

MacMainFrame 5.0 2-19 



Printing, Saving, and Logging Host Data 

2-20 

In earlier versions of MMF, you needed to use the Select All command in order to 
print, save, or log the the entire 3270 window. With MMF 5.0, you no longer need to 
use Select All in order to perform these functions. 

To print, save, or log the entire 3270 window, follow these steps: 

1. Make sure that you haven't highlighted any of the data in your window. 

2. Pull down the File menu. 

The File menu will 
display these options for 
printing, saving, or logging 
the entire window: 

3. Select the option you want. 

Page Setup ... 
Print Window... 3€P 
Saue Window As ... 
Log File ... 
Log Window to... 3€L 

NOTE: As with earlier versions of MMF, you can also print, save, or log only part of 
the data in your 3270 window. If you wish to do this, 

1. Use your mouse to select the data that you wish to print, save, or log. 

2. Pull down the File menu. 

The File menu will now 
present these options for 
printing, saving, or logging 
your selection: 

3. Select the option you want. 

Page Setup ... 
Print Selection... 3€P 
Saue Selection As ... 
Log File ... 
Log Selection to... 3€L 

MacMainFrame 5.0 



Import Configuration Feature For MMF Server Control 

NOTE: This section is only for people who set up MMF Gateway Servers. 

The Import Configuration feature lets you keep your Server's configuration when you 
install a new version of MMF Server software. Import Configuration saves your: 

• Administrator Password 

• Server Parameters 

• SDLC and Token-Ring Parameters 

• Class definitions 

To use this feature, follow these steps: 

1. Move your old Server driver icon (either Coax, Token-Ring or SDLC} out of your 
System folder. 

2. Install version 5.0 of your Server driver and version 5.0 of the Server Control 
software. 

3 Launch the Server Control application. 

4. Pull down the Administer menu and select 
Import Config ... 

New Command-+ 

Administer 
New Class .. . 
Edit Class .. . 
Delete Class ... 

Password ... 

Import Config ... 

LU Numbers ... 

WN 
WE 
WD 

Token-Ring Parameters ... 
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MMF will present 
this dialog box: I a Sernerl n ... I 

D MMF TR Serner $!, 

c:J Hard Disk 

( l:jt~!:t 

( Desktop 

......................................... 

( Cancel 

-0 n Open 

6. Locate and select the old version of your MMF Server driver, then click Open. 

MMF Server Control will import your LU session class configuration. 

7. Save your class configurations in version 5.0 by pulling down the File menu and 
selecting Save. 

MMF will save the information in the new Server driver. 

8. Remove your old MMF Server driver from your hard disk. 

) 

~ 
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MacMainFrame 3287 

In MMF 5.0 there are some changes to the way that you set print parameters for your 
MMF 3287 session. 

Here's how to do it in MMF 5.0: 

1. If you're using MMF Workstation hardware, you must select a Printer LU in the 
Avatar Control Panel. 

2. Launch the MMF 3287 application by double-clicking on the MMF 3287 icon. 

MMF 3287 will display this 
Formatting Options dialog box: 

Set these formatting options 
as you normally would. (See 
your MMF Workstation or MMF 
Client user guide for more 
information.) 

MacMainFrame 5.0 

Please Select Formatting Options: 

Destination: @Printer 0 Disk 

Pages per Job: ~ 
Job Timeout: @] seconds 

End of Line: @Truncate QWrnp 

Spacing: @Single 

Font: I Rrmonk 

Font Size: EJ 

K OK Il 

0 Double 

( Cancel ) 
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3. Click OK after you have filled in your formatting options. 

MMF 3287 will display the Page Setup dialog box for your printer. Example: 

LaserStation "LaserWriter 11 HAL" 7.o ( Print D 
Copies:liml Pages: @ All O From: CJ To: CJ ( Cancel ) 

Couer Page: @No O First Page O Last Page 

Paper Source:@ P.:1per C<1~se11(~ O l'•1<1m1<1! f Pf~!i 

Print: @Black & White O Color/Grayscale 

Destination: @ Printer O Postscript® File 

4. Fill in the Page Setup dialog box and click P r i n t. 

MMF Workstation will then 

( Feeder) 

display the Session 
Parameters screen: 

Please Select Session Parameters: 

LU Number: I ~ 3 I 
Buffer Size: I ~ 24 rows, 80 cols (Mod 2) 

Cancel R Connect Il 

The Session Parameters screen displays your LU Number and lets you select 
your print buffer size. Below is a list of the buffer size selections and their 
equivalent size in bytes. 

24 rows, 80 columns = 1920 bytes 

32 rows, 80 columns = 2560 bytes 

43 rows, 80 columns = 3440 bytes 

27 rows, 132 columns = 3564 bytes 

5. Make any changes that you wish to the Buffer Size and then click Connect. 
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MMF Client will display this screen: 

Please Select Session Parameters: 

HppleTalk Zone: 

Lornllalk EAST m 
LocalTalk lruine 
LocalTalk WEST 
Nouell ERST 
Nouell WEST 
Peripherals 
TokenTalk Seruices 

I 
Seruer: Class: 

Computer Room SOLC m 
PTR P7-L33 

TokenTalk Users ..n. o O 
'--~~~~~~~~v~~~~~~~~~-'-~~================~ 

Cancel ) n Connect » 

• In the Apple Talk Zone: box, select the AppleTalk Zone where the server 
you you wish to connect to is located. 

The Server: box will display a list of Servers that are available in that 
zone. 

• In the Server: box, select a Server. 

The Class: box will display a list of printer classes that are available on the 
server that you selected. 

• In the Class: box, select a printer Class. 

• Click Connect. 

MMF 3287 will then display r:=~D~~~~~~~U~n~ti~t~le~d~~~~~~~ 
this Status window: e 

You are now ready to print. 

MacMainFrame 5.0 

Job Status: 

Job Name: 

Logical Unit: 

Waiting for Print Data 

<none> 

LU 3 

Current page: O 

Current line: O 
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Enabling/Disabling Printing 

2-26 

With MMF 5.0, you no longer need to Enable or Disable MMF 3287 printing. You 
can close the Status window and leave MMF 3287 running in the background. The 
MMF 3287 Settings menu lets you show the status window, change connection 
settings, and change the 3287 formatting. 

Settings 
Connection ..• 
3287 Formatting ••• 

Show Status Window 
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Chapter 3 

MacMainFrame 4.0 

MMF 4.0's Features 
This section and the next two sections describe the features that MMF 4.0 added to 
the MMF product. Since these features are all included in MMF 5.0, too, we've 
referred to them as MMF 4.0/5.0 features throughout this chapter. If you are already 
using MMF version 4.0, you don't need to read this chapter. 

The features in this section are: 

• New icons 

• Balloon Help 

• Support for True Type display technique 

• Support for Session Settings files on Macintosh stationery 

• New Location of Some MMF Graphics Features 

• More Session Classes on MMF GW Servers 

• Ability to run MMF GW Client on a MMF GW Server machine 

• Alternate method of pasting data into 3270 windows 

• Support for file transfer in TOSS environments 

• PA3 Key for DFT keyboards 

Three more features, which are a bit more complex, are described in their own 
succeeding sections: 

• Special Settings menu 

• Support for Macintosh Publish & Subscribe operations 

• Restricted LU Classes 

REMEMBER: Some features are available only when you're running MMF under 
Macintosh System 7.0. This is noted in the text where appropriate. 
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New Icons 

3-28 

The various driver icons for MMF Coax Workstation products have been 
consolidated into two icons, one for DFT Workstations and one for CUT workstations. 
{These new icons are available starting with MMF 3.34.) 

New Icons Old Icons 

-·- -·- -·- -·-
DFT[8 Replaces 5E·l8 S~o!E::J II·l8 

MMF OFT Mac SE OFT SE/30 OFT Mac II OFT 

-·- -·- -·- -·-
CUTE) Replaces 5E·l!1 s~o 1!1 II· l!1 

MMF CUT Mac SE CUT SE/30 CUT Mac II CUT 

The icon for the basic MMF GW Server software has been divided into three 
versions, Coax, Token-Ring, and SDLC Servers: 

~: 
MMFCoax 

Server 

New Icons 

~ 
~: 

MMF Token-Ring 
Server 

~,__ 
~: 

MMFSOLC 
Server 

Replace 

Old Icon 

MMFCoax 
Server, 

MMF Token-Ring 
Server, 

MMFSOLC 
Server 
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The icon for the postscript version of the Armonk font has changed: 

New Icon Old Icon 

~ D 
Armon Armon 

Also: The DX CUT icon has been renamed MMF DX. 

And many of the icons have new colors, which are visible on color monitors. 
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Balloon Help 

3-30 

Available Under Macintosh System 7.0 Only. 

Balloon Help gives you a quick and easy way to get acquainted with the features of 
your MMF product. It's especially useful if you're a first-time user, but you might also 
find it handy as a quick on-line reference. 

When Balloon Help is turned on, balloons appear as you move your cursor over the 
various windows, menus, etc. in your MMF product. For example, when you move 
your cursor over the MMF File menu, you'll see a balloon like this: 

File menu 

Use this menu to manage 
disks, folders, and documents, 
to select and save information 
from 3270 windows, and to 
transfer files. 

You turn the balloons on and off by pulling down the Balloon Help menu: ClJ, which 
appears on the Macintosh's main menu bar. 
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True Type 

Available Under Macintosh System 7.0 Only. 

MMF 4.0/5.0 supports the display technique known as True Type for its print fonts. 
This means that when you print larger fonts, which the Macintosh tended to 
approximate with fairly jaggy versions, MMF smooths the font, and the letters look 
more like they should. 

With TrueType: Without True Type 

R R 
True type also lets you use a wide and continuous range of font sizes, rather than the 
familiar 9-10-12-14-18-24 range. 

True Type works on: 

• Fonts that you print from MMF to your Chooser printer or local Macintosh 
printer. 

• 3287 print fonts, which you use with MMF 3287. 

True Type does not work on: 

• Fonts as they appear in your MMF 3270 windows. 

Session Settings Files Can Be On Stationery 

Available Under Macintosh System 7.0 Only. 

MMF 4.0/5.0 lets you use the new file type, stationery, to save your MMF session 
settings. 

For more information on stationery pads, please see your Macintosh System 7.0 
documentation. 
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New Location of Some MMF Graphics Features 

~32 

In Release 4.0/5.0 of MMF Graphics, we moved two features to a new location in the 
MMF user interface. (This move allows smaller monitor screens to continue to 
display all items in the Session Settings dialog boxes.) 

The two features are: 

• Graphics colors, and 

• Graphics font. 

In MMF 4.0/5.0 they are now available in the Settings menu: 

MMF 4.0/5.0 Location: { 

Session ... 
Host ... 
hrnphic Color~,,, 
hrnphic fnn t ,,, 

Keyboard ... 

Reset Session 
Special ... 

If the current LU session is not set to Graphics, the Graphic Colors ... and Graphic 
Font items will be grayed., as they are in the diagram above. 

REMINDER: Set your LU sessions to Graphics by going to the LU panel in the Avatar 
panel, positioning the cursor over an LU, holding down the OPTION key, and clicking 
until the LU changes to the appropriate type (choices are Terminal, Printer, and 
Graphics). 
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Graphics Color Feature 

With some IBM graphics applications, you have a choice of more colors. To see 
these colors, select Graphic Colors ... in the Settings menu. 

MMF Graphics will display the following dialog box: 

Background ® I White I 0 ----- ip!i@Q I Yellow I Hilight 

M§i§M I Gray 

++14 1.w1.1;;;s 
I Orange I 
H"iii.!lliii 

[ Default Colors ) 

*=11¥4 
I I 

fiffl!'.[ !!!!!!!!!!!!!!O!!!!!K!!!!!!!!!!!!!!!!!!lloD ( Cancel 

To change the way a color appears on the Macintosh, click its color block and MMF 
will display the Macintosh color wheel, which you can use to change the color as you 
wish. 

To restore the colors to their MMF defaults (MMF's best approximation of their 
appearance on an IBM monitor), click the Default Colors button. 

Graphics Font Feature 

When you select Graphics Font ... from the MMF Graphics Option Settings menu, 
you'll see this dialog box: 

Please choose the Macintosh font to 
use in place of the host font. 

Graphic Font Rrmonk 

n OK )J Cancel 

The pop-up menu contains the Armonk font plus all the fonts that are currently in your 
Macintosh System: 
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Please choose the Macintosh font to 
use in place of the host font. 

Chicago 
Courier 
Geneua 

OK Heluetica ncel 

Monaco 
Times 

Select a new font and then click OK, or cancel your selection and close the box by 
clicking Cancel. 

More Session Classes on Servers 

3-34 

MMF 4.0/5.0 supports up to 64 LU session classes on a single MMF Gateway Server. 
This means on a 64-session MMF GW Server, you can have 64 one-session classes. 

To create session classes, as usual you can: 

• Select New Class ... from the Server Control application's Administer menu or 

• Double click on one of the classes in the Classes: scroll window in the Class 
Information dialog box. 

For complete information on creating, editing, and deleting LU session classes, 
please see your MMF Gateway Server Administrator's Guide. 
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Running MMF Client on a MMF Gateway Server Machine 

When your MMF Gateway Server is running MMF 4.0/5.0, you can also start up the 
MMF Client application. 

What You Need First 

To allow your Server to also run a MMF GW Client, check the Allow Client on 
Server machine check box, which appears in the Server Parameters box in the 
Server Control application: 

Seruer Parameters 

Seruer Name: j MacMainFrame'M Seruer 

MaHimum Sessions per User: 

lnactiuity Timeout in minutes: D 
Logging Leuel: @ Full O Errors Only O None 

Log file Name: j Seruer Log File j D Rppend logfile 

New check box --+ D Rllow Client on Seruer machine 

Classes: language: 

IMI• •llL {r ll}.'UlH!Jj -0-
Model-2 ERB i2 us RSCll 

R Model-3 :;:;:' Rustrian/German %11 
Model-3 ERB =~~i11 Belgian ;:;::· 

~ P.!l\ Model-4 
"°' 

Brazilian 
"°' 

How to Use The Server-Resident Client 

Use MMF Client as you normally would. To select a Server, go to the Chooser. You 
can even select another Server elsewhere on the Apple Talk network. 

IMPORTANT: On all Servers, any undue activity on the Server, particularly holding 
down the mouse or formatting disks, delays all traffic for all Clients connected to that 
Server. 

Also, when outlying Clients on a Server perform large file transfers, this can slow all 
activities for the user on that Server, regardless of what application that user is 
running. 
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Alternate Paste Method 

MMF 4.0/5.0 offers two paste methods. 

• The Paste command (or 88 V), and 

• The SHIFT-Paste command (or :HlSHIFT-V). 

The two methods work slightly differently depending on whether or not the pasted 
data contains carriage returns (CRs). Briefly, when you're pasting data that contains 
CRs, and you use SHIFT-Paste instead of Paste, and you're pasting to an 
unformatted screen area (as opposed to a formatted screen), MMF aligns the left 
edge of the pasted data to the first column in which you paste. Otherwise, the two 
methods work the same. 

The following sections provide a more detailed explanation of pasting. 

With No Carriage Returns (CRs) In Data 

3-36 

If the 3270 window is formatted into fields. Both paste methods- Paste and 
SHIFT-Paste - give the same result: MMF pastes the data starting at the cursor, 
restarting at the next unprotected field, and wrapping to the next line when necessary 
to get to the next field. The result could look like this: 

Aaaa aaa a a 
aaaa aaa 

aaaaaaa aa a 
aaaaa aa aaaaaa aaa 

aaaa aaa a aa aaaa 
aa aa a 
aaa 

If the 3270 window lets you type anywhere. Both paste methods- Paste and 
SHIFT-Paste -give the same result: MMF pastes the data starting at the cursor, 
wrapping to the next line and restarting at the left margin when the current line is 
filled. The result would look like this: 

Aaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaa 
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With Carriage Returns (CRs) In Data 

If the 3270 window is formatted into fields. Both paste methods- Paste and 
SHIFT-Paste -give the same result: MMF pastes the data starting at the cursor, 
restarting at the next unprotected field, and wrapping to the next line when necessary 
to get to the next field: 

Aaaa aaa a a 
aaaa aaa 

aaaaaaa aa a 
aaaaa aa aaaaaa aaa 

aaaa aaa a aa aaaa 
aa aa a 
aaa 

If the 3270 window lets you type anywhere -

• The Paste (or H V) method works the same as before: MMF pastes the data 
it has starting at the cursor, and after a CR it wraps to the next line and restarts 
at the left margin: 

Aaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaa 

• The SHIFT-Paste (or X SHIFT-V) method works slightly differently than 
before - MMF pastes the data it has starting at the cursor, and after a CR it 
wraps to the next line and restarts in the column where it began pasting. The 
result would look like this: 

MacMainFrame 4.0 

Aaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaa 
aaaaaaaaaaaaaaaaaaaaa 
aa 
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Putting Carriage Returns (CRs) In Your Data 

To have MMF include carriage return (CR) characters in the data you plan to paste 
from another MMF 3270 window: 

1. Check the Add carriage returns at line ends box. (This check box is in 
the Copy Options dialog box, which is available under the MMF Special 
Settings menu.) 

2. Copy the data using the MMF Copy Table command (which is in the Edit 
menu). 

Support For File Transfer In TOSS Environments 

3-38 

MMF 4.0/5.0 can transfer files to and from TOSS environments, as well as to and 
from environments that use IND$FILE software to transfer files. 

To enable MMF to transfer files in TOSS environments, use the TOSS items in the 
File Transfer panel, which is in the new MMF Special Settings menu. No other 
adjustments to MMF are necessary for MMF to upload and download these files. 
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PA3 Key For OFT 

MMF 4.0/5.0 offers both a PA3 key on OFT (multisession) keyboards and a TEST 
key on CUT (single-session) keyboards. Earlier versions of MMF offered only a TEST 
key. The PA3 key and the TEST key occur in the same position on the MMF 
keyboard. 

NOTE: The actual key that gives the PA3 or TEST function will vary somewhat 
depending on the Macintosh keyboard you're using. 

To find these two key functions: 

On CUT Workstations: 

The TEST function normally 
appears near the lower right 
corner of the Function Keys pull­
down menu: 

_JI II l.._I _ ..... , 

JBBB 
JGC!JCD 

On OFT Workstations and MMF GW Clients: 

TEST also appears in the upper 
panel in the Keyboard 
Configuration dialog box: 

PA1 Tab 

PA2 Test 

1" .J. 

You'll see a PA3 function in the same positions the TEST key was in: 

_JI II II I 

JIHomelBB 
JGC!JCD 

PA1 Tab 

PA2 PA3 

1" .J. 
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Special Settings Menu 
The Special Settings menu offers specialized settings that pertain to various aspects 
of MMF operation. 

How to Use the Menu 

3'-40 

To get to the Special Settings menu, hold down the OPTION key and then pull down 
the Settings menu. Special ... now appears in the menu: 

Session .•• 
Host ... 
1;rnphic Colori- ... 
1;rnphic ront.,, 

Keyboard ... 

Reset Session 
Special. .. 

Select Special. .. , and MMF will display the first panel of the Special Settings dialog 
box: 

Special Settings: Ria rm 

3270 Rlarm Sounds 

D Disable sound 

U OK 3 tancel 
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To get to the other panels, use the pop-up menu at the top of the box: 

Special Settings: 

1270 Alarm Sounds 

D Disable sou 

Alarm 
Connect 
Copy 
Cursor 
File Tnmsfer 
Full Screen Model 4 
Graphic Cursor 
Window Preferences 

D OK D Cancel 

The following sections describe all the Special Settings panels and their items in 
more detail. 
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Alarm 

3-42 

These settings affect the IBM sounds that can occur when you're working in a 3270 
window. 

Special Settings: Ria rm 

3270 Rlarm Sounds 

0 Disable sound 

[ OK B Cancel 

3270 Alarm Sounds 

D Disable sound When this box is checked, MMF shuts off the 3270 alarm 
that the host can send when you're working in a 3270 window. 

Checking this box does not shut off other sounds, for example MMF error 
messages, messages from other applications, etc. 
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Connect 

These settings affect the way MMF manages connections to the IBM host. 

Special Settings: Connect ,..I 

D Disconnect from host after Quitting 

ti OK 3 Cancel 

D Disconnect from host after Quitting When this box is checked, 
when you select Quit from MMF's File menu, MMF disconnects all LU 
sessions from the IBM host before shutting down. 

The default (box not checked) is to leave the LU sessions connected; this 
lets MMF reconnect to them quickly. 
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Copy 
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These settings affect the way MMF copies data in the 3270 window. 

Copy 

Special Settings: I Copy ".":I 
Copy 

D Rdd Carriage Returns at line ends 
D Strip leading Spaces 
D Strip trailing Spaces ................................ _ .. ,_ .................................................................................................................................................................... . 

Copy Table 
[8l Rdd Carriage Returns at line ends 
!8l Strip leading Spaces 
!8l Strip trailing Spaces 

Define Tab-Delimited Fields Dy: 
O Inserting Tabs between Rttributed fields 
®Substituting a Tab for at least i.spaces between chars 

l OK J Cancel 

These boxes offer various modifications to data that you copy from a MMF 3270 
window using the simply Copy command: 

D Add Carriage Returns at 1.ine ends -When this box is checked, 
MMF adds a Carriage Return character to the end of each IBM line. 

D Strip leading spaces - When this box is checked, MMF removes 
spaces from the left end of the IBM line. 

D Strip trailing spaces -When this box is checked, MMF removes 
spaces from the right end of the IBM line. 

Copy Table 

These boxes offer modifications to data that you copy from 3270 windows when you 
use the Copy Table command: 

181 Add Carriage Returns at line ends - When this box is checked, 
MMF adds a Carriage Return character to the end of each IBM table row. 

181 Strip leading spaces - When this box is checked, MMF removes 
spaces from the left end of the IBM table row. 

181 Strip trailing spaces -When this box is checked, MMF removes 
spaces from the right end of the IBM table row. 
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The following radio buttons let you specify how Copy Table will reproduce the 
information it copies. 

Define Tab-Delimited Fields By: 
0 Inserting Tabs between Attributed Fields - MMF will insert a 

TAB between attributed fields that it detects; this insertion takes place 
in MMF's copy of the data. MMF won't insert TABs within fields. 

@ Substituting a Tab for at least g spaces between chars 
- MMF will substitute a TAB wherever it finds the number of spaces 
specified in the edit field (default= 2 spaces); this substitution takes 
place in MMF's copy of the data. This may result in MMF inserting 
T ABs within fields . 
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Cursor 
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These settings affect MMF's emulation of the IBM text cursors. 

Special Settings: I Cursor 

Choose Cursor's Position With: 
® Click O Option-Click O Command-Click 

Position Cursor at: O Mouse position 
® First unprotected position 

-·-·--· .. ··-··-.. ·--··-·-··-··-· .. -···· .. ······· .. ···-·· .. ·-···· .. ····· ................ -..... -................................................ ~·········; ............................. . 
Position Cursor and Send this I curs Sel ...,.., 
RID Key with: 

O Click ® Option-Click O Command-Click 

Choose Light Pen's Position 

O Click O Option-Click ® Command-Click 

I OK B [ Cancel ] 

These radio buttons let you specify how MMF positions the cursor in the 3270 
window: 

Choose Cursor's Position With: 
@Click 0 Option-Click 0 Command-Click 

These buttons let you specify where MMF positions the cursor in the 3270 window. 

Position the cursor at: 
0 Mouse position 
@ First unprotected position 

This item lets you select an AID key from the pop-up and specify a mouse-key event 
on which MMF should send that AID key to the IBM host. 

Position cursor and send I Enter ...,. I 
this AID key with: 

Oc1ick @ Option-Click 0 Command-Click 
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These buttons let you specify the way MMF positions the cursor in the 3270 window 
when the cursor is acting as a light pen: 

Choose Light Pen's Position With: 

0 Click 0 Option-Click @ Command-Click 

NOTE: The standard light pen AID key is Cursor Select. 
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File Transfer 
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These settings affect the way MMF transfers files to and from the IBM host. 

These settings affect all transfers of all files to and from all IBM environments. 

Special Settings: I File Transfer ""I 
O Support file transfer using TOSS 
O Transfer mes In keystroke mode 

O Rdd commands to all Upload commands: 

~ J 
O Rdd commands to all Download commands: 

~ ] 
Rssign This Creator Type To 
Downloaded TeHt Files: 

« OK B 

File Transfer Options 

MacWrite 

Cancel 

D Support file transfer using TOSS When this box is checked, MMF 
can transfer files to and from a TOSS environment. 

When transferring files under TOSS, MMF gives no indications other than 
normal messages that it is doing so. 

NOTE: The IBM host must be running IBM host file transfer software for 
MMF to be able to transfer files to and from a TOSS environment. 

D Transfer files in keystroke mode When this box is checked, MMF 
transfers the given file as if it were being typed at the keyboard. 

This is useful when your MMF product is operating in CUT (i.e., single­
session) mode and is connected to a non-IBM control unit.and a block­
mode file transfer is not feasible. 
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D Add commands to all Upload commands: 

I 
D Add commands to all Download commands: 

When these boxes are checked, MMF adds the commands in the edit box 
to each Upload or Download command line that it constructs. (You can see 
MMF's Upload and Download command lines by first capturing them in a 
batch file. Use the Batch File ... selection in the MMF File menu and the 
Batch button at the bottom of the Upload or Download dialog box.) 

Here's an example of a command line that MMF built to transfer a file 
called TEST.TST to a CICS environment: 

IND$ TEST.TST TEST TST Al(ASCII CRLF) 

If we check the Add commands check box, type QTEMP into the edit 
box, and then request the same file transfer again, MMF constructs the 
command line this way: 

IND$ TEST.TST TEST TST Al(ASCII CRLF QTEMP) 

For complete information on IBM commands, please see your original IBM 
documentation. 

Assign This Creator Type To 
Downloaded Text Files: 

MacUJrite 
MS UJord 

User Defined ... 

The selections in this pop-up cause MMF to label downloaded files with 
types of Macintosh applications that would normally create and/or use the 
files. 

The User-defined ... selection in this pop-up lets you select an 
application type from your own Macintosh - and add that application type to 
the pop-up . 
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1. Pull down the pop-up and select User-defined ... . MMF then 
displays a file box: 

le Uarious MMF .... I 
'8:i MacMainFrame 3287 ft1 
<11 MacMainFrame Checker 
<11 MacMainFrame Graphics 3.4b1 
<11 MacMainFrame Workstation 
CJ Printing fonts 
<11 TeachTeHt 

=JHB-40 

Desktop 

n Select , 

( Cancel J 

2. To select a Creator Type, double-click an application that creates 
files of that type (or select the application and then click the Select 
button). 

NOTE: Make sure that application is not currently locked. 

MMF will apply that application's type to the downloaded file, and it will add 
the type to the pop-up. 
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Full Screen Model 4 Options 

These settings let MMF make adjustments for data that is meant to be displayed on 
Model 4-type terminals, which have tall screens. 

Special Settings: Full Screen Model 4 ,.-1 

D Use special 9 point font 

( OK J Cancel 

D Use special 9 point font When this box is checked, MMF will use a 9 point 
font that is shorter than its normal 9 point font. This allows a full Model 4 screen 
of data to appear on a standard Apple 13-inch RGB monitor . 
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Graphic Cursor 
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These settings affect MMF's emulation of the IBM graphics mouse and graphics 
cursors. 

Special Settings: Graphic Cursor 

Send Left Button Of Graphics Mouse Hfter: 

@ Click O Option-Click O Command-Click 

181 Send RIO Key with left button: I Enter .,..I 

Send Center Button of Graphics Mouse Hfter: 

O Click O Option-Click @ Command-Click 

181 Send HID Key with center button: [i'ii'"iir---.,..-..1 

u OK B Cancel 

These items let you specify how MMF will send the left and center buttons of the IBM 
graphics mouse 

When a box is checked, MMF also sends the AID key that appears in the pop-up 
menu when the mouse/key event occurs. 

Of Graphics Mouse After: Send Left Button 

@Click 0 Option-Click 0 Command-Click 

0 Send AID Key with left 
button: 

I Enter 

Send Center Button Of Graphics Mouse After: 

0 Click 0 Option-Click @ Command-Click 

0 Send Al D Key with 
center button: 

I Enter ..... 
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Window Preferences 

These settings affect the way MMF displays the given LU session's 3270 window and 
the data in the window. 

Special Settings: Window Preferences ..,.I 

Window Preferences For Session: [:I3 

D Hide Window Frame 

~ Show intense fields in Bold 

D Show NULLs or SPRCEs in unprotected fields as: 

~ Ouerride Default Window Title with: 

I 

ll OK > Cancel 

NOTE: The default setting for the "Override Default Window Title with:" item is not 
checked. We've checked it here to show the edit field. 

Use this pop-up menu to select the LU session whose window preferences you want 
to change: 

Window Preferences For Session: [:=g 
0 Hide window's frame -When this box is checked, MMF hides the 

3270 window's frame, which includes the various Macintosh-related 
features such as scroll bars, etc. This, in turn, lets more 3270 data appear. 

NOTE: MMF always displays the IBM status line, whether or not this box is 
checked. 

0 Show intense fields in bold When this box is checked, MMF displays 
in boldface the contents of fields that have the intense attribute. 

NOTE: For black&white monitors only. On color monitors, MMF shows 
intense fields in a different color. 
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D Show NULLs or SPACEs in unprotected fields as __ When this 
box is checked, MMF will fill in each SPACE or null in unprotected fields 
with the character you supply. For example, if you typed in a - (tilde) here, 
MMF would display a five-NULL unprotected field as-----. Supply any 
single printing ASCII character. 

D Override the default titles for 3270 windows with: 
When this box is checked, MMF will title this 3270 window with the phrase 
you supply. This lets you name your windows differently- Tom, Dick, Harry 
- instead of Tom:1, Tom:2, etc. 
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Publish & Subscribe 

Available Under Macintosh System 7.0 Only. 

System 7.0's Publish & Subscribe feature lets Macintosh applications move data to 
and from each other; this communication is essentially direct and does not require 
continual user intervention. For complete information on how Apple's Publish & 
Subscribe feature works, please see your original Apple System 7.0 documentation. 

How MMF Publish & Subscribe Works 

MMF lets you make Publish & Subscribe connections between MMF 3270 windows 
and other applications that are running on your Macintosh. 

The MMF Publish & Subscribe features are available in the MMF Edit menu: 

Create Publisher .. . 
Publisher Options .. . 
Create Subscriber .. . 
Subscriber Options .. . 

Show Borders 

There are two ways to set up the Publish & Subscribe relationship for your MMF 
4.0/5.0 applications: 

1) You can have MMF Workstation or Client contain a publisher, which is an area 
in a 3270 window that gets published for use by other applications, and 

2) You can have it be a subscriber. in which case it receives data at the cursor 
from a publisher - actually from an intermediate file published by a publisher. 

As mentioned, the medium of exchange between publishers and subscribers is the 
edition file - publishers publish edition files, and subscribers subscribe to them. 

MacMainFrame 4.0 ~55 



What Kind of Data Can You Publish And Subscribe To? 

Subscribers - MMF subscribers accept text data. Regardless of the special 
formatting or graphics that may occur in the edition file, what arrives at the cursor in a 
MMF subscriber window is plain ASCII text. 

Publishers - MMF publishers publish plain ASCII text with the exception of MMF 
Graphics. MMF Graphics can publish either text, graphics, or both, depending on the 
layers that are active in the MMF Graphics publisher. 

How Much Can You Publish And Subscribe? 

You can have MMF publish out of more than one 3270 window at the same time, you 
can have MMF subscribe into more than one 3270 window at the same time, and you 
can have MMF be publishing and subscribing at the same time. 

There can be only one subscriber per 3270 window and one publisher per 3270 
window. 

How To Create A Subscriber In MMF 
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To create a subscriber in a MMF application, follow these steps: 

1. Pull down the MMF Edit menu and select Create Subscriber ... 

MMF displays the following Macintosh dialog box: 

Preuiew 

Test Data 1 2345 
TEST DATA 54321 
test data 00000 
TeEsT DaTa 99999 
tEsT dAtA 12345 

la Edition Manager ,.. I 
D Folderl 
a Filel 

=Hobbes 

~ Eject 

Desktop a File2 
a File3 
a File4 

( Cancel ) 

~---------~t-=I~{} n Subscribe D 

2. Use the items in this box to select an edition file to subscribe to. 

After you click Subscribe, MMF creates the subscriber. 
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3. After creating a subscriber, select the way the subscriber will receive new 
editions. Pull down the MMF Edit menu again and select Subscriber 
Options .... 

MMF displays the following Macintosh dialog box: 

Subscriber to: ._I o_t_e_s_t _____ ..... __.I 

,.. Get Editions: ...................................................................................................... , 

I O Automatically I 
j ® Manually ( Get Edition Now j 
I Latest Edition: Wednesday, Apri13, 1991 S:S9:47PM I 
t .................................................................................................................................................. J 

( Cancel Subscriber ) 

( Open Publisher ) 

(Cancel ) 

4. See the Subscriber to: pop-up menu for the edition file's current location. 

5. Specify how you will receive new editions by using the Get Editions buttons: 

• Automatic a 11 y gives the subscriber a new edition each time the 
publisher updates the edition file, and each time you click the Get 
Edition Now button. 

• Man u a 11 y gives the subscriber a new edition each time you click the 
Get Edition Now button. 

• Get Edition Now button gives the subscriber a new edition 
immediately, regardless of how the radio buttons are set. 

REMEMBER: The new edition will come in wherever the cursor in your current 
3270 window is positioned. 

6. Click OK when you're satisfied with the way your subscriber will receive new 
editions. 

Otherwise, click Cancel and MMF will discard any changes you made and 
revert to the previous method of delivering editions. 

To stop a 3270 window from being a subscriber any longer, click the Cancel 
Subscriber button. 

To track down the publisher that is updating the edition file, click the Open 
Publisher button. 
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How To Create A Publisher In MMF 
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To create a publisher in a MMF application window, follow these steps: 

1. Select an area in the current 3270 window that you want to be the publisher -
use the cursor to drag across a section of the window, or use Select Screen 
from the MMF Edit menu to select the whole window. 

2. Pull down the MMF Edit menu and select Create Publisher .... 

MMF displays the following dialog box: 

Preuiew la Edition Manager ..,. I =Hobbes 

RS IS R1 
• PlftHJED LOO ft1 

DIRllS TEST R1 
E:llTE5T DftTll ft1 D Folder1 
ERTEST E~EC R1 
EPSISTAT FILE ft1 
DIJESTS RUT'$PFDF R1 
WEST6 HETLOO ftD 

Name of new edition: 

Eject 

Desktop 

New LJ ) 

Cancel 

Publish 

3. Use the items in this box to select an edition file to publish to. 

After you click Publish, MMF creates the publisher. 

4. After creating a publisher, select the way this publisher will publish new 
editions. Pull down the MMF Edit menu again and select Publisher 
Options .... 

MMF displays the following Macintosh dialog box: 

Publisher to: l._0_1_in_e_1 _____ ,,..._I 

, .. send Editions: .................................................................................................. , 

! O On Saue I Cancel Publisher 

l ® Manually ( Send Edition Now I 
! Latest Edition: Friday, April 5, 1991 4 :42 :57 PM ! 
! ! 

! .................................................. .,. ................................................................................................ ! ( Cancel ) ([ OK JJ 
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5. See the the Publisher to: pop-up menu for the edition file's current location. 

6. Specify how this publisher will publish new editions by using the Send Editions 
buttons: 

• On Save publishes a new edition each time you save the current 
Session Settings document, and each time you click the Get Edition 
Now button. 

NOTE: Save here causes MMF to publish all publishable areas in all 
3270 windows. 

• Man u a 11 y publishes a new edition each time you click the Send 
Edition Now button. 

• The Send Edition Now button publishes a new edition immediately, 
regardless of how the radio buttons are set. 

7. Click OK when you're satisfied with the way your publisher will publish new 
editions. 

Otherwise, click Cancel and MMF will discard any changes you made and 
revert to the previous method of publishing editions. 

To stop an area from being a publisher any longer, click the Cancel Publisher 
button. 

How MMF Handles Publish & Subscribe Data 

MMF handles Publish & Subscribe data differently depending on whether you are 
using plain text data, as you would with MMF Workstation or MMF GW Client, or you 
are using text data and graphics data, as you would with MMF Graphics Option. 

Plain Text Data 

All the MMF applications - MMF Workstation, MMF GW Client, and MMF Graphics 
Option - let you publish and subscribe to plain text data. 

MMF treats plain text data it publishes the same way it treats plain text data it 
copies: 

• MMF converts all white space (SPACEs, TABs) to SPACEs, and does not 
insert any extra carriage return (CR) characters, plus 

• MMF also follows the current settings in the Copy Options dialog box, which 
modify the above conventions. (Copy Options appears in the Special 
Settings menu.) 
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MMF treats the text data it subscribes to the same way it treats the text data it 
pastes: 

• MMF pastes the data at the current cursor position. 

Text Data And Graphics Data 

Only MMF Graphics Option lets you work with both text and graphics data. With MMF 
Graphics Options, you can: 

• Publish both text and graphics data 

• Subscribe to text data. 

When you subscribe to text data, MMF Graphics Option works the same as the other 
MMF applications. 

When publishing data, MMF Graphics works differently than the other MMF 
applications: 

• If no graphics data is visible, MMF publishes any text in the publisher area as 
TEXT. (Your MMF layer selector icons will all be grayed when no graphics are 
visible.) 

• If graphics data is visible, there are three possibilities: 

If you select this layer: (Icon in the layer MMF will publish: 
selector palette:) 

ALL layers ~ GRAPHICS + TEXT 

GRAPHICS layer only ~ GRAPHICS 

TEXT layer only [i) TEXT 

Borders of Publishers 
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The basic Macintosh Publish & Subscribe software normally displays a border around 
an area that's currently set up to be a publisher. 

Here's a publisher. The 
border lies at the edge 
of the_p:ublisher area. 
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MMF 4.0/5.0 lets you hide this border if you wish and then restore it to view. To do 
so, select the Show Borders/Hide Borders item in the MMF edit menu. (If the 
borders are showing, the Edit menu selection will be Hide Borders - selecting it will 
hide the borders and change the selection to Show Borders - and vice versa.) 

NOTE: MMF shows its publishers' borders within the first few pixels of the publisher 
area, rather than outside the publisher area. 

You Can Save Your Publish & Subscribe Settings 

Once you've set up a Publish & Subscribe relationship between MMF and an edition 
file, you can save that relationship in a MMF Session Settings document. 

When you use that Session Settings document again, MMF will reestablish the 
subscription and/or publication to the appropriate edition files. Edition files persist 
across MMF restarts as well as Macintosh restarts and power-downs. 

What About Deleted Publishers and Subscribers? 

When you cancel a publisher or subscriber, MMF puts the cancellation into effect 
right away. 

In the case of publishers, MMF will also try to delete the associated edition file . 

• If the Session Settings document is new (never been saved) and no 
subscribers are currently reading the edition file, MMF will delete the edition file 
when you close the 3270 window where the publisher resided. 

• If the Session Settings document isn't new, MMF won't delete the edition file 
until the next time you save the Session Settings document. 

See the next section for information on cancelling publishers and subscribers. 

How To Delete Publishers and Subscribers 

To stop an area in a 3270 window from being a publisher any longer: 

1. Go to the 3270 window where the publisher occurs. 

2. Pull down the MMF Edit menu and select Publisher Options .... 

3. Click the Cancel Publisher button. 

MMF will also delete the associated edition file, either right away if this is a new 
(never been saved) Session Settings document, or if it isn't a new document, the next 
time you save the document. 

To stop a 3270 window from being a subscriber any longer: 
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1. 

2. 

3. 

Go to the 3270 window that is the subscriber. 

Pull down the MMF Edit menu and select Subscriber Options .... 

Click the Cancel Subscriber button. 
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Restricted LU Classes 

For MacMainFrame Gateways and Clients Only. 

Introduction 

This feature lets you restrict the use of your MMF 4.0/5.0 Gateway Server's LU 
session classes to a small number of MMF Clients according to information that 
resides on the Client machine(s). Using these restrictions, you can restrict an LU 
Session class so that only one Client can use the LU sessions in that class. 

These restrictions work regardless of whether other Clients are on the same LAN, 
how many other Clients know the Server's name, or even how many other Clients 
know the class's password. 

To restrict the use of a MMF LU session class, you use the Server Control application 
to record certain information about the Client(s). You record this information in the 
Server Control's Class Information dialog box. The information that you can record is: 

• A user name, which the Client user also records in the Client Chooser. 

• The Client's current network address, for example its Token-Ring address or 
Ethernet address. 

• The Client's "unique Client ID", which you, the Server Administrator, supply. 

How The Restrictions Work 

Briefly, to restrict the use of a session class, the Server checks each Client that 
requests LU session classes. If the Client's information matches the requested 
class's information, the Server lets the Client use LU sessions from the class. If the 
information doesn't match, the Server simply continues to inform the Client of 
available LU sessions in available classes. 

Benefits of Restricted LU Classes 

Restricting an LU session class to a single Client lets you give that Client special 
access to that class's LU sessions: 

Guaranteed Access - As long as you don't give the sessions in that class to 
any other Client, you can guarantee the Client can always get the LU sessions 
in that class (assuming the sessions are available from the host). 
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Security-You can prevent other users, who try to use one Client's same 
physical terminal or who try to contact the Server with the same Chooser user 
name, from using that Client's LU sessions. 

Multiple Restricted Classes -You can construct several different classes for 
the same Client. This lets you give the Client a variety of session types - for 
example terminal, printer, and graphics, or Model 2, Model 3, Model 4 - again, 
that the Client can always get since no other Clients have access to the 
classes. 

Overall Security 

If you're using these restrictions to create secure working environments, you should 
also restrict access to the tools that set and clear these restrictions: 

• The Server machine itself 

• The Server Control application 

• The MMF Checker application, 
which can be run on the Client. 

Physically secure the machine. 

Remove this software from the Server 
machine. 

Remove this software from the Client 
and Server machines. 

How To Set Up Restrictions 
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To restrict an LU session class to a single MMF Client: 

1. You must obtain information about the Client, and 

2. You must supply this information to the class itself, which you do by using the 
Server Control application. 

The following sections explain how to do this. 
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1. Obtaining Information From The Client 

You'll need to decide which information to base your restrictions on. The choices are: 

Chooser user name - Software-specific security 

Network address - Hardware-specific security, especially for Token-Ring 
and Ethernet LANs 

Unique Client ID - Hardware-specific security, especially for LocalTalk 
LANs 

The following sections explain these choices in more detail. 

Chooser Name 

The Chooser name is the name the Client user supplies in his or her own Chooser. 

• In Macintosh System 6.0, 
users can supply this name in 
the Chooser dialog: 

• In Macintosh System 7.0 to 
use certain Chooser choices, 
for example an AppleShare 
server: 

MacMainFrame 4.0 

~D Chooser 

~ ~. ~ 
App1eShir• Applehlk I... !il!ll 

"'''' 

User Name: 

IJon Burrowes 

A leTalk ® Activ.e 
PP 0 Inactive 

3.6 

Connect to the file seruer "Hua tar Corporate 
Seruer" as: 

QGU(!~t 

@ Registered User 

Name: !Jon Burrowes 

[ cancel [Set Password J lf OK )J 
v7.0 
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REMEMBER: Client users can change their own Chooser user names at will and can 
thus use user names that may give them unauthorized access to LU session classes 
and LU sessions. 
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Network Address 

The Network Address varies according to the kind of LAN to which the Clients are 
connected. 

• Token-Ring LANs - Network Address is what the Token-Ring board is currently 
using as a Token-Ring address, and there are two choices here: 

Burned-In Address (Some LANs call this the hardware address, the permanent 
address, etc.) 

Locally Administered Address (Some LANs call this the software address.) 

To determine which address the Client 
will use (and therefore which address the 
Server will check for), you must run the 
MMF Checker on the Client and go to the 
Checker's Token-Ring parameters panel, 
which is available in the Checker's 
Control menu. 

To have the Client use the Burned-in 
Address, set the Locally Administered 
Address to NULL/Zero. 

To have the Client use the Locally 
Administered Address, set the Locally 
Administered Address to anything but 
NULL/Zero. 

- Set Token-Ring 
Para mete rs: 

Slot: Q ~} @ A Q H Q C Q 0 Q [ 
Burned-In Address: 00013F 1B1500 

Locally Administered 1400000000027 I 
Address: . · 
Ring Speed: @ 4 Mbps O 16 Mbps 

Host's Address: l 400000000001 I 
XID - Physical Unit Block: @I2J 
XID-Terminal ID: 100001 I 
Maximum I-Frame Size (bytes): 140151 

(C8iiUi) [( OK JI 

• Ethernet LANs - Network Address is the Ethernet address. Ethernet addresses 
are 12 hexadecimal digits in length. 

• LocalTalk LANs - The network address is not static and can change from day 
to day. Instead, use a Unique Client ID. Unique Client IDs are described in the 
next section.) 
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Unique Client ID 
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The Unique Client ID is an alphanumeric value that you, the Server Administrator, set 
at the Client by running the Checker application on the Client. 

The Unique Client ID is useful in LocalTalk environments as a class restriction 
criterion, since LocalTalk network addresses are not static and may change from day 
to day. 

Here's how you supply the unique Client ID to the Client: 

1. Start the Checker on the desired Client. 

2. Go to the Checker's 
Control Menu. 

3. Select Set Unique 
Client ID .... 

4. The Checker will display 
this dialog box: 

5. In the edit box, type in a 
unique alphanumeric 
string. 

This value may be up to 
12 characters in length. 
Range: A - Z, a - z, O - 9. 

Connect to DH ••• 
Configure DH .•. 

Driuer Status .•• 

Hardware Status ... 

Configure Token-Ring ••• 

Set Unique Client ID ... 

Set Unique Client ID 

Unique Client ID: II 
~-----~ 

O Show only restricted classes. 

® Show restricted and unrestricted classes. 

(Cancel ) 
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Optionally, you may also select the way this Client displays available classes by 
using the radio buttons: 

0 Show only restricted classes. Means the Client will display only the classes 
to which it has have access 

®show restricted and unrestricted classes. Means the Client will display 
all classes on the current Server. 

IMPORTANT: These radio buttons apply to all restrictions types, not just the Unique 
Client ID. 

No Restriction 

You can also elect not to restrict access to the class. To do so, select "No Restriction" 
from the pop-up menu (in the Class Information dialog box). 

The "No Restriction" selection also removes the restrictions that the other selections 
might have invoked, and treats the data you might have typed in for those restrictions 
as follows: 

• Zeroes out network addresses. 

• Leaves Chooser name as is. 

• Leaves Unique Client ID as is. 

Any Client can now get LU sessions from this class (assuming that the Client 
supplies a valid password if necessary and that there are LU sessions available from 
the host). 

Note that you can still use the class password to restrict access to the class. 
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2. Setting Up The Restrictions On The Server 
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Go to your MMF Gateway Server(s), select or create the LU Sessions classes that 
the Clients will be using, and use the information you collected in the previous step to 
create the restrictions. The steps below explain how to do this. 

1. Start the Server 
Control application 
running on your 
Server. 

2. Pull down the Server 
Control's Administer 
menu and select 
either New Class ... or 
Edit Class .... 

Server Control will 
then display the Class 
Information dialog 
box: 

3. Make sure you've got 
the class you want. If 
necessary, fill in the 
class's correct name 
in the Class Name 
edit box. 

MMF Server Control 

Delete Class... ~D 

Password ... 

LU Numbers ... 

Token-Ring Parameters ... 
SULC Parameters ... 

Class Information 

Class Name: 

Oeuice Type: @Terminal O Printer 

Screen Size: @ 24H80 (2) O 32H80 (3) 
Q 43H80 (4) Q 27H132 (5) 

Attributes: @ Base O ERB O RPR 

Password: 

Restrict Class Recess by: I No Restriction 

(nssign LUs to Class) 

fil!f!!!!( !!!!!!!!!!!!!!OK!!!!!!!!!!!!!i!] Cancel 
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4. Pop up the 
Restrict Class 
Access by: pop-up 
menu. You'll see the 
choices of information 
by which you can 
restrict this class: 

Class Information 

Class Name: 

Deuice Type: ®Terminal O Printer 

Screen Size: ® 24H00 (2) O 32HOO (3) 
Q 43H00 (4) Q 27H132 (5) 

Attributes: ® Base 0 ERB 0 RPR 

Password: 

Restnct Class Access by: No Restnct1on 
Chooser Name 
Network Address 
Unique Client ID 

Assign LUs to ass 

([ OK J) Cancel 

5. Select one of the Restrict Class Access items and supply the appropriate 
information. 

NOTE: Obtain this information by going to the Clients to which you're going to 
give access and recording it from them. 

The Server Control application will reject your input if the information is 
incorrect. For example, if you supply a non-hexadecimal digit as part of a 
hexadecimal network address, Server Control will beep and await a valid digit. 

6. Click OK to put your new settings into effect and close the dialog box, or click 
Cance I to discard any changes you've made and close the dialog box. 

REMEMBER: Make sure the class contains the LU sessions you want it to contain. 

To assign LU sessions to 
LU session classes, click 
the Assign LUs to Class 
button, which is at the 
bottom of the dialog box: 
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(Assign LUs to Class] 

en !!!!!!!!O!!!!K!!!!!!!!~JJ Cancel 
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Server Control will then display a 
Member LU panel: 

Cancel 

Rssign 

([ OK ~ 

For complete information on assigning LUs to LU session classes, see Chapter 6 in 
the MacMainFrame Series Gateway Server Administrator's Guide. 

The following sections show how to set each kind of restriction. 
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No Restriction 

Set this restriction by selecting 
No Restrictions in the 
Restrict Class Access pop-up 
menu: 

Chooser Name 

Set this restriction by selecting 
Chooser Name in the 
Restrict Class Access pop-up 
menu: 

In the Chooser Name edit 
field, type the name as it 
appears in the Client user's 
Chooser. 
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Class Information 

Class Name: J Model-2 ERB 

Deuice Type: ®Terminal 

Screen Size: ® 24H8D (2) 
Q 43H80 (4) 

0 Printer 

Q 32H80 (3) 
Q 27H132 (5) 

Rttributes: 0 Base @ERB 0 RPR 

Password: 

Restrict Class Recess by: v"'No Restriction 
Chooser Name 
Network Rddress 
Unique Client ID 

Assign LUs to ass 

n OK ll Cancel 

Ae~tr-ict C lau Acee~~ by· 

Rssign LUs to 

n OK B Cancel 

Chooser Name 

(RHign LUs to Class) 

ll'J!!!!( !!!!!!O!!!!!!K~J Cancel 
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Network Address 
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Set this restriction by selecting 
Network Address in the 
Restrict Class Access pop-up 
menu: 

Type a valid network address 
in the Network Address 
edit field. 

Restrict Class Access by: No Restriction 
Chooser Name 

'11 • 

Unique Client ID 
Hssign LUs to ass 

I OK D Cancel 

Restrict Class Access by: I Network Address I 

Network Hddress 

(Assign LUs to Class) 

U~( ~OK~] Cancel 

REMEMBER: The Network Address varies according to the kind of LAN to which the 
Clients are connected. For more information, see the section "Obtaining Information 
From The Clients" above. For complete information about your LAN, see your 
network administrator. 
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Unique Client ID 

Set this restriction by selecting 
Unique Client ID in the 
Restrict Class Access pop-up 
menu: 

Type a valid ID in the Unique 
Client ID edit field. Valid IDs 
can be up to 12 alphanumeric 
characters in length. Range: A 
- Z, a - z, o - 9. 

Restrict (lass Rrress by· 

Hssign LUs to 

u OK JI 

Unique Client ID 

No Restriction 
Chooser Nome 
Network Hddress 

Cancel 

(nssign LUs to Closs) 

~n """""""'oK~J Cancel 

REMEMBER: You must set the Unique Client ID on the Client by running the 
Checker application on the Client. For complete information on setting the Client ID, 
see the section "Obtaining Information From The Clients" above. 
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Security Precautions 

While the restricted LU session class features provide some specific security 
measures, you should also remember the following: 

You Can Assign An LU Session To More Than One Class 
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Assigning an LU session to more than one LU session class is part of basic MMF 
Gateway Server functionality; it lets you give your Client users access to as wide a 
selection of LU sessions as possible. 

When you double-assign LU sessions in a restricted class environment, in most 
cases MMF warns you about the double-assignment and asks you to confirm it: 

• Assigning an LU session 
from a restricted class to 
another restricted class: 

• Assigning an LU session 
from a restricted class to 
an unrestricted class. 

• Assigning an LU session 
from an unrestricted class 
to a restricted class. 

Warning: One or more LUs in this 
restricted class ore accessable 
from other classes (for eHample, 
LU2 ). 

(( OK D Cancel 

Server Control DOES NOT ISSUE A WARNING. 

Warning: One or more LUs in this 
restricted class are accessable 
from other classes (for eHample, 
LU2 ). 

(( OK )J Cancel 

If you click OK in the Warning box, Server Control will make the double assignment. It 
will also allow Client users access to the classes, providing the Clients meet any 
restriction criteria. 
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IMPORTANT: If the result of this double-assignment is that the LU session now 
belongs to an unrestricted class, any Client user can then get access to the session 
via that class, even if the LU session also belongs to a restricted class. 

This could result in the LU session's regular user(s) not being able to get an LU 
session one day because another user got it first via an unrestricted class. On the 
other hand, if other users only used the unrestricted class on off hours, the session's 
regular user(s) might never find out that the session had now become open to 
unrestricted use. 

To avoid this problem, we suggest you assign LU sessions to all your unrestricted 
classes first, then carefully assign LU sessions to your restricted classes. If you 
assign your restricted classes first, you may accidentally double-assign a restricted 
LU session to an unrestricted class later, and Server Control will carry out the 
assignment without warning you of this double-assignment. 

Macintosh Users Can Select Their Own Chooser User Names 

Macintosh users specifying their own Chooser user names is part of basic Macintosh 
functionality. 

When you restrict the use of a MMF LU session class on the basis of Chooser user 
name, any user who supplies that user name can then use LU sessions in that class. 

You may want to use this technique to widen the access to a class to more than one 
user, but you may also want to use a different method to restrict access to the class. 

Basic Security 

Remember, MMF's restricted LU session classes are not meant to replace basic 
security. Whenever you use MMF's security features, you must secure the Server 
Control and MMF Checker applications and you should secure your MMF Gateway 
Server machines. 
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